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The meeting on Monday |0th
August 2015 will be at
Tiger Tiger

29 Haymarket, London SW 1Y 4SP

7pm Newsbyte

7.15 Software Snapshot

7.30 Announcements

There will be a photowalk in August. The
most likely date is Sunday |6th August and it will
take place in or around Regents park starting with
a picnic then going off to take photos.

The next Apple Special Event is predicted for
September 9th.
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My working procedure

n an attempt to make life simpler and more secure,

I now keep all my photographs and specific projects

on separate SSDs. | now have five of these drives,
mostly in 500GB size but some are 250GB. They are
small (about 10x7x| cm) light weight and of course
they have no moving parts. The ones | bought through
Maplin on line are Samsung. They are of course much
more expensive than conventional portable hard
drives, but they are very much lighter and they have no
moving parts. | started by keeping each drive in a case
at a cost of about £14 a go, but now | keep them out
of their cases and connect them to my MacBook Pro
with a SATA to USB cable. | also used to load them
all onto a USB hub but often not all of them would
be recognised, so now | just have two at most plugged
into the two USB locations on the MacBook. Anytime
['want to work on the next edition of SoundByte | just
plug in the appropriate SSD and open the files, work
on them, then save them back to the drive. There are
two other publications | work on regularly and then
there is my ever increasing collection of photographs
stored on two fairly full 500GB drives. | find it all a
very secure and a most satisfactory way to store and
work with all my files and photos wherever | may be
and without the clutter and weight of conventional
external drives with their weight, heat and motors that
had failed far too frequently. for my peace of mind. My
camera photos are stored on the SD cards | use in the
camera and when a card is full | place it in an envelope
with the contents and dates recorded. | then put a
new SD card into the camera and these days | mainly
use 8GB cards that are surprisingly inexpensive buying
through Amazon. By working in this way | feel far more
secure and less likely to lose any of my work.
Maurice Baker
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Your Mac can do millions of things,
but sometimes even the best of us forget some
of the cool stuff it can do - so we're here to help
JOg your memory.

Some of these tips need recent ver-
sions of OS X - such as OS X 10.9 Mavericks or
OS X 10.10 Yosemite - but not all of them do. In
some cases, some are little features that Apple
has sneaked into upgrades that you might have
totally missed, and some might be a classic light-
bulb moment of “I'd totally forgotten you could
do that!”

This is neither a formal nor an exhaus-
tive list; we've just put our heads together to
gather the tips we think are awesome.

1. Do unit conversions in Spotlight

As well as being able to do calculations in
Spotlight, in Yosemite it gets an extra trick: unit
conversions.You can do specific unit conversions
if you need to —"13 stone in Ibs”, say — but it's
also intelligent enough that in many cases if you
just give it the amount and unit you want to
convert, it will suggest not just the likely conver-
sion but also plenty of alternates. Type in'$1299’
and you'll immediately be told what that is in
Sterling (based presumably on what's set as your
native currency in the Language & Region pane
of System Preferences), and then when the win-
dow folds down to show more results, you'll see
Euros,Yen and so on.

2.Talk to and listen to your Mac!

In OS X 10.8, the Mac’s ability to listen to you as well
as talk is really impressive. Although these are some-
times framed as being accessibility features, they can
be useful for everyone. For example, it's a good idea
to read through any important text before you send it
off, but it's easy to skip mistakes when you're reading
your own work. Instead, select the text and go to Edit
> Speech > Start Speaking. You can control the speed
and pick from a range of different voices (our favour-
ite's the Scottish ‘Fiona’) in the Dictation & Speech
System Preference pane.

If you find you use the feature often, you
should enable the option to trigger speaking aloud
using a keyboard shortcut - the default is Option+Esc,
which you can change in the Dictation & Speech
pane. (If you do have restricted vision, investigate the
VoiceOver feature in the Accessibility pane of System
Preferences too; this can read aloud buttons and other
on-screen items, and more.)

Your Mac is just as good a listener as it is a
talker, though. Not only can you control your Mac
using Speakable [tems (check the Accessibility
pane) but in OS X 10.8 you can also dictate text
anywhere you would type. By default you just

press the Function key twice and then start talk-
ing.

3. Run Windows

We know, we know - who wants to run Windows? But
sometimes it's handy, whether to play the latest games
or run some niche piece of software that has no Mac
equivalent.You can either run Windows alongside OS X
with a virtualisation app such asVMware Fusion, Parallels
Desktop or VirtualBox, or partition your hard disk to
install Windows on to run it full-bore on your hardware
using Boot Camp Assistant (in your Utilities folder).
4.Add clips from websites to Dashboard

Remember Dashboard? Introduced with 0.4, this
overlay holds ‘widgets' that can perform handy little
tasks - Apple still hosts a catalogue of them at apple.
com/downloads/dashboard. One oft-forgotten trick is
that you can make your own widgets by clipping from
web pages. The best bit is that the web page remains
live. Here's how to do it (we're going to clip out some
cricket scores, but it will pretty much work for any part
of any site).

I Navigate to the page you want to clip a
section from in Safari. (It has to be Safari, not Chrome,
Firefox or whatever.) You can clip out information that's
essentially static - say, a list of keyboard shortcuts you
want to refer to - or stuff that's changing all the time.

2. Go to the File menu and choose Open
in Dashboard...; now you can mouse over sections of
the web page, and it's usually smart about snapping to
appropriate areas. If not, just click then drag the handles.
Once you're done, click Add at the top right.

3. Once the clipping has been added to your
Dashboard, you can click the i at the bottom right to flip
it round. Here you'll see options for the frame; pick the
one you like. The web clipping should update anyway,
but if you need to force a manual refresh, click it, then
tap Command+R.
5.Type exotic characters
As well as letters and symbols you see on your key-
board, you can type a bewildering array of special char-
acters.You may already be familiar with typing accents
such as for café (in that case you either type Option+E
then E again or, on OS X 10.7 or later; hold down the
E until you get extra options) but you'll find there are
many more.

Go to the Edit menu of most apps and you'll
see Special Characters at the bottom.This panel gives
you access to a huge range of symbols you can drag
into your documents. Not all apps or operating systems
support them, but these are mostly part of the cross-
platform Unicode standard. There are probably more
than you see at first, too; click the cog to reveal more.

Emoiji (those fun, colourful characters avail-
able in OS X 10.7 or later) are a notable exception to
this cross-platform world. They're not Apple-only, but
your recipient might not be able to see them.

Apple Pro Tips




Apple Pay and the Apple Watch,
happy playmates

've been fretting about not having a credit or

debit card enabled for Apple Pay. Last week

there was a flurry of activity and | found that |
had two likely suspects in my wallet so | decided
to have a go.

Setting up on the iPhone is
straightforward: Go to the Passbook application in
Settings and tap to add a card. The camera springs
into life and it's then a simple task to scan the
card. The system reliably reads the card number
and identifies the issuer but is less precise on
expiry date. | had to enter this manually, as | did
the secure code from the back of the card. Once
this is done, the card issuer sends a verification
code by SMS and this is entered into Passbook to
complete the installation.

Watch hitch

| had less success initially with the Watch. |
dutifully ticked the “Mirror Phone” option in

the Apple Watch app on the phone but was
surprised to see that neither credit card was
visible on the watch. After a lot of reading of help
papers and forums on the Apple site | realised
that the two devices are independent for the
purposes of Apple Pay. It is necessary to set up
the card again on the Watch, but through the
Apple Watch app on the phone. Confused? You
will be.

This is only an initial problem. Once
you've understood and done it and successfully
added a card, you are in business. In use, Apple
Pay is even more simple. With the phone it's

a matter of using Touch ID on the home button
and waving the device across the swipe reader:
Transactions (which are limited to £20 in the UK,
just like swipe purchases) appear on the phone as a
list.

Transaction check

With the Watch things are slightly
different. When you are ready to pay you simply
double press the side button and the screen tells
you to place the phone near to the card reader.

An encouraging buzz on the wrist tells you the
transaction is complete. There is, however, one big
difference. There seems to be no way to check
transactions from the Watch or the phone and you
have to wait for the items to appear on the credit
card bill. This is a problem for me since | am in the
habit of entering all transactions immediately into my
favourite accounts system, Moneydance. I'll have to
remember to keep hold of the receipts.

Initially, | had assumed that Apple Pay on
the Watch and the iPhone would be completely
integrated but | now understand that they are
separate systems, almost certainly for security
reasons. it's something we can live with. But it would
certainly be nice to see a list of transactions either
on the Watch or in the iPhone app.

Yesterday | used the Watch to buy
groceries at Marks & Spencer, much to the delight
of the staff who hadn't seen this magic trick before.
Then, later; a coffee at Caffe Nero was the occasion
for more interested discussion. | was the first
Watch payer in that particular branch. | love being a
pioneer and that was what frustrated me about the
delay in implementation by many card issuers. Today
| did a big purchase, a MacBook at £1,299.A couple
of presses of the button and the transaction was
approved in a couple of seconds. As far as | know,
though, only Apple accepts Apple Pay for sums over
£20.

Apple Pay is likely to become one of the
most-used features of the Watch—or the iPhone
for that matter—because it is just so convenient
and easy. It is the future, as we move inexorably to
a cashless society. | used to get very annoyed when
the person in front at Starbucks insisted on using a
credit card for a £2.25 coffee; all that palaver and
delay with entering PIN numbers was a sure-fire
irritant. Then came swipe cards and | realised | was
less affronted. Now it's watch and phone swiping
and | feel quite relaxed about it. | realise that within
a year or two NFC payments will be the norm.

All the articles on this page
come from Michael Evans
www.macfilos.com. These
and many others are well

3 worth reading.
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Learn to Record Anything with “Take

Control of Audio Hijack”
ecording audio from a Mac app is concep-
RZually simple, but without the right tools
nd know-how, it can be tremendously
frustrating. Adam and the TidBITS crew have
long relied on Rogue Amoeba's Audio Hijack
for all recording tasks, and now we're pleased to
bring you Kirk McElhearn’s new “Take Control
of Audio Hijack” to explain both the basics and
the subtleties of Audio Hijack 3's new flowchart-
like interface, which is vastly different from the
previous version’s approach (see “Audio Hijack 3
Bumps Up the Volume,” 30 January 2015).

You'll learn how to capture and
enhance any audio playing on a Mac, with step-
by-step instructions for common scenarios —
including recording audio playing in Safari, captur-
ing Skype and FaceTime calls, digitizing your old
LPs, extracting audio from concert DVDs, work-
ing with microphones and mixers, and more. Kirk
also covers the basics of editing recordings in
Rogue Amoeba’s Fission audio editor.

| could go on for a while about all the
good stuff that Kirk distilled into the | 19-page
book, but if you've read this far and want more
detail, click over to the book's full description on
the redesigned Take Control Web site.

Finally, | just wanted to share that | had
such a nice time making “Take Control of Audio
Hijack” In addition to getting to work with Kirk,
whose enjoyment of audio is infectious, it was
great to have expert editing help from our friend

Geoff Duncan, who has many years of experi-
ence as a producer; technician, and studio musi-
cian. And Rogue Amoeba’s Paul Kafasis provided
amiable and helpful suggestions during our tech
edit phase, making an already good book even
better. But the real win was learning Audio Hijack
and Fission, which are the epitome of cheerful,
uncluttered apps with surprising depths. Using
them improves my mood, which is true of too
few apps these days. If you need to work with
audio, give them a try.

Audio Hijack 3.2 -- Rogue Amoeba has
issued Audio Hijack 3.2 with refinements to the Time
Shift Block that make it easier to use Audio Hijack for
transcribing audio. Time Shift gets a new popover with
controls for 3-, 10-, and 30-second jumps as well as a
long slider for easy movement around the buffer.You
can tear off the popover for better access, as well as
pin it so it floats above other windows for access from
within other applications. The popular audio record-
ing utility also adds the Sync Block for adding precise
delays to audio, adds the Peak/RMS Meters Block for a
fully calibrated visualization of your audio, updates the
Instant On component to version 8.1 (with initial sup-
port for OS X 10.1'1 El Capitan), supports tags in FLAC
files, and ensures correct audio playback of FLAC files
in the Recordings tab. Learn all the secrets about Audio
Hijack with Kirk McElhearn’s new *Take Control of
Audio Hijack,” which covers common scenarios (such
as recording audio playing in Safari), how to digitize
old LPs, and even using Audio Hijack to enhance audio
from streaming services like Netflix. ($49 new with a
20 percent discount for TidBITS members, free update,
15.4 MB, release notes, 10.9+)

To read the whole story, go to:
TidBITS




